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1 . Запуск Unigraphics и главное окно 

После инсталяции Unigraphics NX в списке программ Start > All 

Programs (Старт > Все программы) появится программная группа UGS NX 8 

с набором ярлыков для запуска. Не будем останавливаться сейчас на 

описании всех ярлыков, а щелчком мыши на ярлыке NX 8 запустим 

приложение. Также во время инсталяции системы производится ассоциация 

файлов данных NX с расширением «prt» (и ряда других). Поэтому при 

двойном щелчке на файлах этого типа также будут произведѐны запуск NX и 

загрузка соответствующего файла. После инициализации приложения и 

проверки доступности лицензии будет открыто главное окно системы. В 

случае с запуском по двойному щелчку на файле модели она будет загружена 

и отображена в графической области. Если же запуск был произведѐн с 

помощью ярлыка, то вы можете создать новый файл модели или открыть 

существующий. Рассмотрим основные элементы главного окна приложения 

(Рисунок 1.1): 

 

 

 

Рисунок 1.1 – Главное окно Unigraphics 
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1 – заголовок окна, в котором помимо названия системы отображаются 

текущее приложение, имя рабочей детали и еѐ состояние в случае изменения; 

2 – строка главного меню, состав которой зависит от текущего 

активного приложения и роли;  

3 – панели инструментов, набор и состав которых также зависит от 

приложения и роли; 

4 – панель выбора, которая содержит набор команд и опций, 

управляющих механизмом интерактивного выбора пользователя в процессе 

работы над моделью; 

5 – строка статуса и подсказки, в которой отображаются контекстные 

подсказки для пользователя и текущий статус выполнения операции; 

6 – панель ресурсов, содержащая набор различных вкладок, каждая из 

которых отвечает за определѐнную функцию, например вкладка Навигатор 

модели, отображающая дерево построения модели; 

7 – кнопка переключения между стандартным и полноэкранным 

режимами; 

8 – «рельс» крепления диалоговых окон. Этот элемент интерфейса 

предназначен для позиционирования диалоговых окон команд, вызываемых 

пользователем; 

9 – графическая область, в которой отображается моделируемая 

геометрия. 

В данном случае NX работает в «классическом» режиме, характерном 

для всех Windows приложений. Существует ещѐ один режим – 

полноэкранный. Основное назначение данного режима – максимально 

расширить графическую область и минимизировать количество 

отображаемых панелей инструментов и меню. Переключиться в 

полноэкранный режим можно, нажав  Alt+Enter или выбрав в строке главного 

меню команду View > Full Screen (Вид > Полный экран). 

По сравнению со стандартным режимом, здесь нет множества панелей 

инструментов, строки главного меню и панели ресурсов – все они собраны в 
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единый менеджер инструментов, который может отображаться как в 

расширенном, так и в сокращѐнном виде. Все остальные элементы 

интерфейса стандартного режима присутствуют. Полноэкранный режим 

подойдѐт опытным пользователям, которые научились максимально 

использовать контекстные меню команд, а также соответствующие 

клавиатурные сокращения. Все, что им нужно в этом случае, – максимально 

большое пространство, отображающие геометрию модели. Для менее 

опытных пользователей или для тех, кто любит пользоваться панелями 

инструментов, больше подойдѐт стандартный режим. 

 

2 . Приложения 

Как уже говорилось, набор панелей инструментов, и содержимое и 

состав главного меню зависят от текущего активного приложения и роли. 

Приложением называется набор инструментов, решающих задачи 

определѐнной области. Переключение между приложениями производится c 

помощью кнопки Start (Начало), либо используя соответствующую 

комбинацию клавиш. При наличии необходимой лицензии система запустит 

выбранное приложение и отобразит набор инструментария, входящий в него 

(Рисунок 2.1).  

 

 

 

Рисунок 2.1 – Приложения Unigraphics 

http://www.consistent.ru/soft/software_4889.html
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Некоторые приложения работают в сочетании с другими, некоторые 

работают поодиночке. Одним из ключевых приложений является  

Gateway(Базовый модуль) оно само по себе не решает никаких задач 

проектирования, расчѐтов или производства, но работает как основной для 

других приложений и отвечает за операции взаимодействия с файловой 

системой, отображение геометрии и многое другое. 

 

3 . Роли 

Набор инструментов в рамках каждого приложения NX выражается в 

виде кнопочных инструментальных панелей и дополнительных элементов 

главного меню. Редко когда для решения какой-либо задачи в ход идут все 

возможные команды приложений, поэтому пользователи предпочитают 

отображать только часто используемые команды и убирать те, которые не 

нужны. Так, каждый пользователь системы NX по мере освоения настраивает 

интерфейс системы под себя. Для облегчения этого процесса в NX 

предусмотрен механизм ролей (). Роль – это сохранѐнное состояние 

интерфейса, в котором запоминаются набор отображаемых панелей и 

элементов меню, их состав и положение на экране.  

 

 

Рисунок 3.1 – Роли 
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Для управления ролями в панели ресурсов существует вкладка Роли. В 

состав дистрибутива NX входит набор преднастроенных ролей, которые 

можно использовать в их изначальном виде, или  настроить на их основе 

свои роли. Для новых пользователей, которые только осваивают систему, 

больше подойдѐт роль Основы (Рекомендуется) – будет отображѐн 

минимальный набор инструментальных панелей, каждая кнопка будет иметь 

название под пиктограммой. Для более опытных пользователей более 

удобной может быть роль Расширенная с полным меню – количество 

отображаемых инструментов будет максимально, а кнопки будут иметь 

компактный вид без текста. 

 

4 . Панели инструментов и главное меню 

Инструментальные панели инструментов группируют команды по их 

функциональному назначению. Ряд панелей представлены только в 

определенных приложениях, как, например, панели простановки размеров в 

модуле Черчение (Drafting), другие панели присутствуют во всех 

приложениях, как, например, панель Вид (View) или Стандарт (Standard). 

Пользователь имеет возможность управлять как видимостью отдельных 

панелей на экране, так и их наполнением. Видимость панелей регулируется 

контекстным меню, появляющимся при нажатии правой кнопки мыши на 

любой отображаемой панели или кнопке. 

Практически все панели могут быть перемещены, прикреплены к 

другим краям графической зоны или полностью откреплены. Для этого 

достаточно взять нужную панель за еѐ левый край, обозначенный 

вертикальным рядом точек, и перетащить еѐ. Перетаскивание в окрестностях 

еѐ исходного положения будет перемещать панель относительно соседних 

панелей, перетаскивание в графическую зону отсоединит панель полностью, 

а перетаскивание к какому-либо краю графической зоны прикрепит еѐ к 

этому краю. Каждая кнопка инструментальной панели снабжена 
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всплывающей подсказкой, которая появляется при наведении курсора мыши 

на кнопку. 

Помимо инструментальных панелей, при работе используются общее 

главное меню приложения и большой набор контекстных меню, привязанных 

к конкретной команде или объекту. Главное меню приложения дублирует все 

команды инструментальных панелей,  большая часть которых содержится в 

пунктах меню Вставить (Insert), Изменить (Edit) и Инструменты(Tools), а  

также ряд дополнительных команд и опций.  

Контекстные меню существуют практически для всех объектов в NX и 

вызываются по нажатии правой кнопки мыши на этом объекте. При этом 

наполнение этих меню зависит от того, какой объект был использован для 

вызова. Так, например, щелчок правой кнопкой мыши на пустом 

пространстве графической зоны вызывает компактную панель выбора и 

меню, содержащее команды навигации и визуализации. А если вызвать 

контекстное меню, например, для ребра геометрического объекта, то оно 

будет содержать команды, которые могут быть применены к этому ребру, 

такие как фаска и cкругление (Рисунок 4.1). Это даѐт возможность 

существенно ускорить работу при моделировании, так как большинство 

нужных команд находится всегда под рукой и нет необходимости их искать 

на инструментальных панелях.  

 

 

Рисунок 4.1 –Контекстное меню 
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Ещѐ один механизм, полезный при работе над моделью, – набор 

настраиваемых радиальных инструментальных панелей. Их можно 

отобразить, нажав одновременно Ctrl+Shift и одну из кнопок мыши. К 

каждой кнопке привязана своя панель (Рисунок 4.2). Меню отображается 

непосредственно возле курсора мыши, поэтому имеет смысл поместить в эти 

радиальные панели наиболее часто используемые команды. 

 

 

 

Рисунок 4.2 –Радиальное меню 

 

Особенностью радиальных меню является то, что они зависят от 

текущего активного приложения, то есть их наполнение будет меняться в 

зависимости от того, в каком приложении работает пользователь. 

 

5 . Создание эскизов 

Эскизом считается именованная группа двумерных кривых, связанных 

геометрическими и размерными отношениями и расположенных на одной 

плоскости. Вы можете создавать эскизы на основе любого существующего 

плоского объекта, а также на кривой. В последнем случае в точке кривой, где 

будет привязан эскиз, система создаст плоскость, расположенную по 

нормали к кривой. Данный тип расположения эскизов используется для 

создания тел протягиванием эскиза вдоль траектории. 

Начиная с версии NX7.5 для создания эскиза предлагаются два набора 

инструментов. 
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 Эскиз в среде задач (Sketch in Task Environment) и инструментальная 

панель Прямой эскиз (Direct Sketch). Первый представляет собой отдельный 

модуль, который запускается вызовом команды Вставить > Эскиз в среде 

задач и предназначен для редактирования эскизов, на которые ссылаются 

много конструктивных элементов. Прямой эскиз позволяет строить 

двумерные контуры непосредственно в текущем приложении NX и больше 

подходит для создания новых эскизов. Функционально эти два средства 

создания эскизов отличаются на три команды: Кривая пересечения 

(Intersection Curve), Точка пересечения (Intersection Point) и Проецирование 

кривой (Projected Curve), которые отсутствуют в Прямом эскизе. Для 

создания эскиза в среде задач вызовите соответствующую команду из 

главного меню и укажите плоскую поверхность размещения эскиза (Рисунок 

5.1).  

 

 

 

Рисунок 5.1 – Создание эскизов в среде задач 

 

Если эскиз должен располагаться на кривой, то необходимо выбрать 

соответствующий подтип эскиза в выпадающем списке диалога. Обычно для 

задания исходных данных эскиза достаточно только указания плоскости. Но 

иногда бывает полезным (а в некоторых случаях обязательным) указать 

направление оси Х и начало системы координат в опциях диалога 
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Ориентация эскиза (Sketch Orientation) и Начало эскиза (Sketch Origin). После 

задания этих параметров или принятия значений по умолчанию система 

координат эскиза расположится на плоскости и будет открыта среда создания 

эскиза с соответствующим инструментарием. 

Прямой эскиз может также задаваться с помощью аналогичного 

диалога, для этого необходимо нажать кнопку  Эскиз (Sketch) на 

инструментальной панели Прямой эскиз. Но можно, просто выбрав на этой 

панели команду рисования какого-либо двумерного объекта, и начать его 

рисовать на любой плоской грани тела или плоскости (Рисунок 5.2). В этом 

случае направление системы координат и еѐ начало будут приняты по 

умолчанию. 

 

 

 

Рисунок 5.2 – Создание прямого эскиза 

 

Дальнейшая работа по созданию плоского контура одинакова для 

обоих инструментов создания эскизов. С помощью команд рисования 

геометрии на инструментальной панели. Инструменты эскиза (Sketch Tools) 

рисуется геометрия, на которую потом накладываются размерные и 

геометрические ограничения (Рисунок 5.3).  



13 

 

 

Рисунок 5.3 – Инструменты построения эскиза 

 

В момент рисования того или иного двумерного объекта система 

пытается автоматически определить, каким геометрическим ограничениям он 

подчиняется, и накладывает эти ограничения. Этот режим регулируется 

кнопкой Создать контекстные ограничения (Create Inferred Constraints). 

Для ручного задания ограничений или для задания дополнительных 

ограничений необходимо воспользоваться кнопкой  Ограничения 

(Constraints). При выборе геометрии эскиза в диалоговом окне команды 

будут отображаться те ограничения, которые наложены на выбранную 

геометрию и которые можно наложить (Рисунок 5.4). В зависимости от 

количества и типа выбранных объектов будут отображаться разные типы 

ограничений. Если придерживаться правильного подхода к проектированию, 

то все элементы эскиза должны быть связаны размерными и 

геометрическими ограничениями – то есть эскиз должен быть полностью 

определенным и не иметь свободных степеней свобод. Это гарантирует 

предсказуемость и управляемость эскиза при изменениях геометрических 

элементов модели, на которые ссылается эскиз. 
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Рисунок 5.4 – Задание геометрических условий 

 

В версии NX8 был представлен механизм постоянного образмеривания, 

который регулируется одноименной кнопкой на панели Прямой эскиз. Этот 

механизм автоматически накладывает размерные ограничения на все 

создаваемые элементы эскиза, тем самым обеспечивая определенность 

эскиза. При этом создаваемые размерные ограничения являются 

вторичными. Это выражается в том, что автоматически сгенерированные 

размерные ограничения удаляются при добавлении пользователем любого 

ограничения, которое с ними конфликтует. Таким образом, эскиз остается 

всегда определенным – вне зависимости от того, сколько ограничений было 

наложено пользователем. Очевидно, что автоматически добавленные 

размеры не могут реализовывать задуманную логику изменений эскиза, 

поэтому необходимо либо принять предложенные размеры, либо 

переопределить их в ручном режиме.  

Для принятия размерного ограничения, созданного системой, 

необходимо произвести двойной щелчок левой кнопкой мыши на выбранном 

размере. В модели будет создан соответствующий параметр, значение 

которого будет связано со значением размера, – то есть размер станет таким, 

как если бы он был поставлен вручную. 
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При необходимости использования существующих ребер модели в 

эскизе их можно спроецировать на текущую плоскость эскиза с помощью 

команды  Проецирование кривой (Projected Curve). Также с помощью 

команды Кривая пересечения (Intersection Curve) можно получить 

пересечение плоскости эскиза с выбранной гранью тела. Обе команды 

создают ассоциативные кривые, которые отслеживают состояние исходных 

геометрических элементов (Рисунок 5.5).  

 

 

 

Рисунок 5.5 – Задание геометрических условий 

 

После завершения построения геометрии эскиза и наложения 

размерных и геометрических ограничений необходимо нажать кнопку 

Закончить эскиз (Finish Sketch) для выхода из режима создания эскиза. Для 

редактирования существующего эскиза необходимо выбрать его двойным 

щелчком левой кнопки мыши в Навигаторе модели или графической области.  

Выполнить: 

Давайте на практическом примере рассмотрим построение простого 

эскиза: 

• Запустите NX8 и с помощью команды главного меню Файл  > Новый 

(File > New) создайте новую модель. 
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• Вставьте рабочую систему координат в новую модель, 

воспользовавшись пунктом меню Вставить > База/Точка > Координатная СК 

(Insert > Datum/Point > Work CSYS).  

Она по умолчанию совпадет с абсолютной системой координат модели. 

• Расположите новый эскиз в плоскости YZ, выбрав пункт главного 

меню Вставить > Эскиз в среде задач и указав соответствующую плоскость. 

В диалоге создания эскиза примите все предложенные значения опций и 

нажмите ОК для перехода в среду редактирования эскиза. 

• С помощью команды Профиль постройте контур примерно так, как 

это показано ниже (Рисунок 5.6). 

 

 

Рисунок 5.6 – Создание эскиза 

 

Замыкая контур, сделайте перехлест прямых, чтобы они пересекались с 

некоторым запасом. Это необходимо для демонстрации функции выбора и 

обрезки.  

• С помощью инструментов Контекстный размер и Ограничения 

задайте некоторые размеры и ограничения. 

Как правило, первое, что необходимо сделать при образмеривании, это 

задать стационарные объекты, относительно которых будут располагаться 

другие элементы эскиза. Задать стационарный объект можно, сославшись на 

грань или ребро другого тела или привязавшись к осям системы координат.  
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• Нажмите кнопку задания ограничений и выберите одну из 

вертикальных прямых, а затем ось Y. В диалоге команды будут отображены 

возможные геометрические ограничения. Выберите условия коллинеарности 

(Рисунок 5.7). 

 

 

Рисунок 5.7 – Условие коллинеарности 

 

• То же самое проделайте с горизонтальной прямой и осью X. Таким же 

образом можно задавать положение какого-либо конца кривой или отрезка на 

оси системы координат или на другой кривой – при этом необходимо 

подвести курсор к концу отрезка и дождаться, пока загорится маркер точки. 

• Задайте размеры относительно стационарных элементов. 

• Полученный искусственно перехлест можно устранить в эскизе с 

помощью команд Создать угол или Быстрая обрезка на панели инструментов 

эскиза. Но на данном этапе можно его оставить и выйти из эскиза. 

• Сохраните модель для продолжения работы с ней в следующем 

разделе. 

 

6 . Создание тел 

Для созданий тела на основе эскиза необходимо воспользоваться одной 

из команд вытягивания эскиза в заданном направлении или вращения вокруг 

оси. Наиболее часто используемые их них–это команды Вытягивание 
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(Extrude) и Вращение (Revolve), распложенные на инструментальной панели 

Элемент (Feature) или в разделе главного меню Вставить  > Элементы 

проектирования (Insert > Feature).  

Рассмотрим команду Вытягивание (Рисунок 6.1). Для еѐ работы 

необходимый минимальный набор исходных данных состоит из плоского 

контура или прямой и вектора направления, которые задаются 

соответственно в разделах диалога Сечение (Sections) и Направление 

(Direction). При этом возможно сразу из команды запустить редактор эскиза 

и нарисовать его с нуля. В этом случае эскиз будет считаться внутренним и 

не будет доступен в Навигаторе модели до тех пор, пока не будет 

сконвертирован во внешний. В качестве контура для вытягивания могут 

выступать любые кривые, в том числе и ребра существующих тел.  

 

 

 

Рисунок 6.1 – Диалог команды Вытягивание 

При выборе плоского контура направление по умолчанию определяется 

по нормали к плоскости контура, но при необходимости его можно 

переопределить, нажав кнопку Задать вектор (Specify Vector). В разделе 

Ограничения (Limits) задаются лимиты перемещения эскиза от плоскости его 

построения в обе стороны. Они могут задаваться как напрямую, указанием 

величин, так и ссылкой, с помощью выбора одного из следующих значений 

опции: 
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До следующего (Until Next) – контур будет вытянут до пересечения с 

другим твердым телом, встреченным в направлении вытягивания; 

До выбранного (Until Selected) – контур будет вытянут до выбранной 

грани существующего тела или поверхности. Если вытянутый контур не 

полностью пересекает выбранную грань или поверхность, то по возможности 

будут использоваться смежные грани или поверхности. Если такой 

возможности нет, то будет сгенерировано сообщение об ошибке; 

До расширенного (Until Extended) – модификация опции До 

выбранного, которая позволяет выбирать ограничивающие объекты, не 

полностью пересекающие протягиваемый контур. В этом случае система 

автоматически рассчитывает продолжение выбранной грани или поверхности 

и использует еѐ для построения; 

Через все (Through All) – протягивает контур в заданном направлении 

через все встречающиеся тела; 

В разделе диалога Булевы операции (Boolean) можно сразу задать тип 

логической операции, применяемой к телу, если в модели уже есть твердые 

тела. Среди возможных значений этой опции следует отметить значение 

Контекстный (Inferred). При этом значении система сама определяет 

подходящий тип операции, исходя из взаимного расположения создаваемого 

тела и существующего. Такой вариант следует применять, когда не 

предполагается изменения модели, которое может вызвать изменение 

взаимного расположения задействованных тел, иначе тип применяемой 

логической операции может измениться. 

Одновременно с вытягиванием контура можно задать дополнительные 

трансформации получаемого тела в разделах Уклон (Draft) и Смещение 

(Offset) или воспользоваться соответствующими командами после создания 

элемента вытягивания. 

Тип получаемого тела определяется в разделе диалога Настройки 

(Settings), но эта опция действует только в случае использования замкнутого 
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контура, в противном случае получаемый элемент вытягивания будет 

представлять собой поверхность. 

Команда Вращение по большинству параметров совпадает с командой 

Вытягивание, только ей необходимо указывать ось вращения и точку начала 

для получения тела вращения проворотом на заданный угол выбранного 

эскиза.  

После получения первого тела в модели далее можно изменять его с 

помощью конструктивных элементов или проводя операции логического 

сочетания с другими телами. Все операции будут добавляться согласно 

хронологии создания в дерево построения, отображаемое в Навигаторе 

модели (Part Navigator) (Рисунок 6.2). 

 

 

 

Рисунок 6.2 – Дерево построение модели 

 

Помимо операций получения тел вытягиванием или вращением эскиза, 

в разделе главного меню Вставить > Элементы проектирования предлагается 

набор предопределенных примитивов и конструктивных элементов, 

комбинируя которые можно получить геометрию модели.  

Но в общем случае создание тел вытягиванием и вращением является 

более универсальным, так как позволяет задать любое сечение (Рисунок 6.3). 
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Рисунок 6.3 – Конструирование элемента 

 

Продолжим работу с эскизом, созданным в предыдущем разделе. 

• Вызовите команду Вытягивание и выберите сделанный эскиз. 

Возникнет сообщение об ошибке, так как эта команда может работать либо с 

замкнутым контуром, либо с открытым, но не работает в случае с 

перехлестом. Как уже говорилось, перехлест можно устранить 

соответствующими инструментами эскиза, но можно пойти более простым 

путѐм. 

• На панели выбора установите правило Связанные кривые и включите 

режим отслеживания пересечений, нажав кнопку Остановка по пересечению. 

После этого укажите одну из кривых в замкнутом контуре эскиза. На этот раз 

эскиз будет воспринят, а лишние кривые будут проигнорированы (Рисунок 

6.4). 

• В разделе диалога Ограничения выберите Симметричное значение 

(Symmetric Values) в выпадающем списке Конец (End) и задайте какое-то 

числовое значение. При таком режиме задания пределов тело будет 

получаться путем вытягивания в обе стороны от плоскости эскиза. 

• Завершите построение эскиза нажатием кнопки ОК в диалоге. 

Элемент вытягивания был построен на базе заранее созданного эскиза. 

Многие команды в NX, которые в качестве входных данных принимают 

плоские кривые или эскизы, позволяют создать его во время выполнения 

команды. 
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Рисунок 6.4 – Вытягивание эскиза 

 

• Вызовите ещѐ раз команду Вытягивание и вместо выбора кривых 

нажмите кнопку создания эскиза в разделе Сечение и выберите ту же 

плоскость, где был расположен первый эскиз. 

• С помощью команды Пересечение получите пересечение плоскости 

эскиза с двумя внутренними гранями (Рисунок 6.5), а затем отрезком 

замкните контур, соединив конечные точки кривых, и завершите построение 

эскиза. 

 

 

Рисунок 6.5 – Прямые пересечения с плоскостью эскиза 
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• Задайте симметричное значение и в разделе Булевы операции 

убедитесь в том, что система выбрала операцию объединения, после чего 

завершите построение тела (Рисунок 6.6). 

 

 

 

Рисунок 6.6 – Добавление тела 

 

• Откройте Навигатор модели. Выделите последний построенный 

элемент и в контекстном меню по правой кнопке мыши выберите пункт 

Сделать эскиз внутренним (Make Sketch Internal). Эскиз будет помещен 

внутри элемента вытягивания. Для обратной операции – создания 

независимого эскиза – необходимо воспользоваться пунктом контекстного 

меню на элементе Сделать эскиз внешним (Make Sketch External).  

• Сохраните модель и закройте еѐ. 

Таким образом, создавая тела на основе эскизов или используя 

стандартные контсруктивные элементы, вы формируете геометрию модели. 

При создании модели в режиме моделирования с историей построения 

необходимо стараться сохранять читаемость истории построения и делать еѐ 

максимально линейной.  

Практически все операции в дереве построения модели основываются 

на одном или нескольких предыдущих элементах, как явно, так и неявно. С 

одной стороны, это дает использовать все преимущества параметризации, но 
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с другой – непродуманная привязка элементов друг на друга могут испортить 

логику построения модели. 

В общем случае при привязках рекомендуется отдавать предпочтение 

стационарным объектам или объектам вероятность изменения которых 

минимальна. Естественно это не должно быть в противоречии с задуманной 

логикой модели.  

При использовании каких-либо геометрических объектов предыдущих 

элементов построения желательно стараться ссылаться на ближайшие к 

текущей операции элементы. Это позволит, как минимум, быстро 

отслеживать связь между изменением ссылочной геометрии и  получаемым 

результатом. 

Также рекомендуется документировать модели.  В процессе 

построения появляется множество вспомогательных элементов, эскизов, 

кривых и прочих объектов, которые усложняют чтение модели, если они не 

организованы. Для организации можно использовать слои и ссылочные 

наборы, размещая и группируя на них основные и вспомогательные 

геометрические элементы построения. 

 

7 . Навигатор модели 

Навигатор модели служит для отображения и навигации по элементам 

построения и предоставляет ряд инструментов для работы с ними. Он может 

работать в режиме отображения хронологии, то есть отображает историю 

построения, и в режиме отображения тел в модели с их составляющими.  

Нажимая правую кнопку мыши на элементах построения, можно 

отображать контекстное меню со специфичными командами для данного 

типа элементов, но ряд команд одинаков для всех элементов. Рассмотрим 

основные команды контекстного меню, используемые при работе (Рисунок 

7.1): 
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Рисунок 7.1 – Контекстное меню элемента построения модели 

 

Изменить параметры (Edit Parameters) – открывает окно 

редактирования элемента или окно с параметрами элемента,  в зависимости 

от того, какой элемент был выбран. Особенностью этой команды является то, 

что она поддерживает множественный выбор – в этом случае будет открыто 

окно с параметрами всех выбранных элементов.  

Изменить с откатом (Edit with Rollback) – активирует режим 

редактирования выбранного элемента с откатом истории построения на 

момент создания данного элемента. 

Подавить (Suppress) – деактивирует выбранный элемент в истории 

построения. Если этот элемент является родителем для других объектов в 

дереве построения, то они также будут деактивированы. 

Переставить перед/после (Reorder before/after) – перемещает 

выбранный элемент в дереве построения. Возможность переместить элемент 

определяется его связями с соседними элементами.  
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Группа элементов (Group) – открывает диалог задания группы 

элементов. Группы служат для уменьшения дерева построения и создания 

логических блоков, из которых состоит модель. 

Замена (Replace)  – открывает диалог перезадания исходных данных 

для выбранного элемента. 

Показать размеры (Show Dimensions) – отображает размерные линии, 

соответствующие значениям, заданным в момент создания элемента. 

Сделать элемент текущим (Make Current Feature) – откатывает историю 

построения модели до выбранного элемента. 

Все эти команды используются для внесения изменений в элемент 

модели и контроля процесса их прохождения по дереву построения. Обычно 

редактирование какого-то элемента модели совершается путем двойного 

щелчка правой кнопкой мыши на элементе.  

Открывается диалоговое окно, соответствующее этому элементу, в 

котором можно произвести нужные изменения. Когда необходимо 

производить изменения в сложной детали или когда происходит сбой в 

прохождении изменения по дереву построения, то с помощью команд 

Изменить с откатом и Подавить можно локализовывать сложные участки 

дерева построения и проводить изменения шаг за шагом. 

 

 


